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1 MindManagerとは 

1.1 マインドマップ 

 Tony Buzanによって１９６０年代後半に開発されたマインドマップという手法は、

アイデアをまとめ、コミュニケーションを支援する手法として世界中で広く使われる

ようになっています。マインドマップは一見単純ではありますが、脳の潜在能力を最

大限に引き出すために、単語、イメージ、数、ロジック、リズム、色および空間の意

識を使って一枚の絵に思考をまとめる手法です。マインドマップは、ビジネスのみな

らず、教育、トレーニングのための手法として画期的なものだといえるでしょう。 

 

図 1-1 マインドマップの例 

マインドマップについての書籍は、日本でも何冊か出ているので、そちらを参考にさ

れるとよいでしょう。 

関連リンク：http://www.mind-map.com/

 

 

1.2 MindManagerとは 

 マインドマップを使ってアイデアをまとめていく手法は画期的なものでしたが、紙

に書くことが基本でした。確かに、紙に書くことが人間にとっては、非常に馴染みや

すい方法ですが、最初に書いたマインドマップを再利用したり、編集したりすること

が簡単ではありません。マップを何度も一から書き直すようなことをせず、パソコン

上で簡単にマップが書けないだろうかということで、過去いくつかのツールが出てい

ます。私も過去そういったツールにトライしたことがありましたが、あまりに実用的

でなく、マインドマップを書くこと自体止めてしまいました。簡単に使えるツールが
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ない限り、人間は長続きしないものです。ところが、MindJet 社が開発した

MindManagerというマインドマップを書くツールは、私にマインドマップを書く意

欲を猛烈に刺激しました。表紙にあるマインドマップも、MindManagerで書いたマ

ップです。この本では、MindMangerというツールを使うと、いかに簡単にマインド

マップがかけて、様々な応用ができることをみなさんに知って頂きたいと思います。 

 
1.3 MindManager X5について 

 MindManager X5は、２００３年１０月にMindjet社から発売された新しいバージ

ョンです。WindowsXP ベースの GUI が採用されただけでなく、従来のバージョンと

はまったく違うアーキテクチャーにより開発されています。ここでは、MindManager 

X5を使った説明をして行きます。MindManager X5の英語の説明を読むと、従来と

違った用語の定義がされています。例えば、ブランチという言葉は、トピック(topic)

という言葉で説明されています。この中では、それに従った説明をします。 
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2 ブレインストーミングに使おう 

 ブレインストーミングという手法は、みなさんよくご存知のように特定の問題を解決

する手法として広く知られています。日本の製造業では QC活動の中で一般的に使われ

てきました。ブレインストーミングのルールは以下の通りです。 

・他人の発言に対して良い悪いの批判をしない。 

・アイデアは自由になんでも出す。制限をしない。 

・アイデアは質より量を求める。 

・ 他人のアイデアをヒントにして自分のアイデアを出す。  

MindManager X5 にはブレインストーミングモードが用意されています。このモード

にすると、次の画面で示すように画面上部にアイデアを入力するフィールドが現れます。

そこにアイデアを入力すると、フローティングトッピックとなって、画面上に表示され

ます。フローティングトッピックというのは、真中のタイトルボックスと線で結ばれて

ない状態を指します。 

 

ブレインストーミング

モードにする 
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    図 2-1 ブレインストーミングモードになったところ 

ブレインストーミングに参加しているメンバから次々に上がってくるアイデアを入

力していきます。アイデアが増えて来ると、はやり分類したくなりますので、次に示す

ように画面上部のグループ名を入力するボタンを押して、色別にグループ名を入力しま

す。 

 
 
 
 
 
 
 
 
 
 
 
 

アイデアを入力 

 

グループ名 

入力ボタン 
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表示された

グループ名 

図 2-2 ブレインストーミングモードで入力中 

ndManagerのブレインストーミングモードでは、体裁を気にせずに参加メンバか

イデアをどんどん入力していきます。一通り意見が出尽くしたところで、リーダ

んなの意見をMindManagerで分類していきます。 
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図 2-3 みんなのアイデアをランダムに打ち込んで分類したところ 

 
図 2-4 ブレインストーミングモードを解除して、タイトルトピックに関連付ける 
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ここまで読んだ方は、どうやって全員が同じ画面をみることができるか不思議に思うでし

ょう。パソコンの画面をメンバ全員が見る方法として一般的に２通りあります。 

1)パソコンの画面をプロジェクタでスクリーンに映し出す 

2)参加メンバ全員がパソコンを用意して、画面を共有するツールを使う。Windows

上で動く Net Meetingがそれに当たります。MindManager自体も電子会議をする機

能を持っており、それについては後で述べます。 

1)のプロジェクトを使う方法が一般的だと思います。 

 

3 議事録作成に使おう 

 私が気に入っている使い方は、MindManagerを、議事録を取るために使うことです。

議事録は、通常紙のノートに取ることが多いと思いますが、取っている間は他の参加者

の発言を聞き漏らすことも多く、その場ではざっと殴り書きをして、あとで清書すると

いうパターンが多いのではないかと思います。 

しかし、MindManagerを使って議事録を取るとかなり効率がよくなります。発言者

の発言を一字一句書き取るのではなくて（それは速記者の仕事ですね）、キーワードだ

けをMindManagerで打ち込んで行きます。先ほど説明したブレインストーミングモー

ドを使えば苦になりません。それに会議中もキーワードを分類して話をまとめて行く作

業が驚くほど簡単にできます。会議が終わると、結構まともなマップになっていること

に気づくでしょう。 

会議が終わった後に分類を細かくしたり、アイコンをつけたりしてマップにメリハリ

をつけます。完成したら、マップをWebから閲覧できるようにするか、MindManager

で作成したファイルを参加者にメールで送ればよいでしょう。MindManagerで作成し

たファイルは驚くほどサイズが小さく電子メールに添付しても苦になりません。 
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図 3-1 マインドマップで作成した議事録 

マインドマップで表現した議事録は、全体を把握することが容易でお互いの関連をよ

く理解できます。紙に書いた議事録は、頭から順番に読んでいくので最後まで読んだと

きに、お互いの関連を見逃してしまう恐れがあります。MindManagerで議事録を作成

することは、マインドマップに馴染むよい方法だと考えます。 
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4 チーム・コミュニケーションに役立てる 

 マインドマップは、他人とのコミュニケーションを促進するものだと言われています。

最近、ソフトウエア開発の世界では、UML(Unified Modeling Language)と呼ばれる記

法が有名です。これを使うメリットはいろいろありますが、ソフトウエアの設計の中身

をビジュアル化して見せるという特徴があり、これによりお互いに相手がどんな設計を

しているのかが理解しやすくなっています。これと同じように人間が頭で考えているこ

とをビジュアル化できれば、当然お互いの理解が進みます。 

マインドマップでは、キーワード、色、グラフィック等を使って思考をビジュアル化

することができるので、チーム・コミュニケーションに非常に役立ちます。次に示すマ

ップはあるプロジェクトのマスターマップと呼ばれるもので、プロジェクト情報への入

り口を示しています。 

 

図 4-1 プロジェクトマスターマップ 

図４－１でプロジェクトの定義をクリックすると、図４－２に飛んで行きます。プロ

ジェクトのメンバ全員がこのようなマップを常に参照できる環境を持つことにより、プ

ロジェクトの全体像を理解しやすくなり、プロジェクトの目的を明確に把握できるよう

になります。 
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図 4-2 プロジェクトの定義 

図４－１で顧客満足度をクリックすると、図４－３で示す顧客の満足度を示す指標を示し

ます。 

 

図 4-3 顧客満足度 

このようにプロジェクトの情報をすべてのメンバがビジュアルに認識することによ

り、プロジェクトの全体像をすばやく理解し、プロジェクトへの参画意識を高めること

 11



が可能です。また、プロジェクトリーダーだけがマインドマップを書くのではなくて、

参加メンバ全員でマップを作り上げるようにしていけば、よりメンバのコミュニケーシ

ョンが図れます。 

次のマップは、セミナー報告をマインドマップで書いた例です。マインドマップで書

くと、セミナーを受講した社員が、何に対して特に興味をもったのか、今後それをどの

ように生かしていこうとしたいのかが一目瞭然となります。従来の紙ベースのセミナー

報告と比較してみて下さい。マインドマップは強くあなたの脳を刺激し強い印象をもた

らすはずです。 

 

図 4-4 セミナー報告 
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5 基礎編(MindManagerで新しいマップを作る) 

5.1 タイトル BOXを作る 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

New アイコンをクリックす
ると画面中央にタイトルト

ピックを入れる box が自動
に現れます。 

タ

し

F2
編

 

イ

て

を

集で
トル BOX を右クリック
EditText を選択するか
押すとタイトル文字列を

きます。 
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Libraryの shapesを選択すると中心の

トピックの形状を変えることができま

す。中心のトピックを左クリックして

から、好きな形状を左クリックして下

さい。 
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5.2 トピックを作る 

 

タイトルBOXが選択された
状態で、Insert Topicのアイ
コンをクリックするとメイ

ントピックが自動的に現れ

文字列入力を促します。 
Insert Key でも同じことが
できます。 

 

メイ

対策

力し

Topi
topi
が出

くら

作っ
ントピックとして“通勤

”というキーワードを入

た後、再度 Insert Sub
c をクリックすると Sub
cの入力を促すプロンプト
ます。このようにしてい

でもブランチを階層的に

て行くことができます。 
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5.3 色をつける 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

カラーパレッ

ックに色をつけ

5.4 シンボ

 

 

トを使ってトピ

ます。 

ルを貼り付ける 

シンボルを貼り付けたいトピックを

マウスで選択した状態で、Library

のウインドウを開き、シンボルをマ

ウスでクリックします。これだけで

任意のトピックにシンボルを貼り付

けることが可能です。 
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5.5 リンクを貼る 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

HiperLink アイコンをクリックすると画面上に
Hyperlinkを設定する popup windowが現れます。

 

“プロジェクト定義”のトピックに、プ
ロジェクト定義.mmp というマップを
リンクさせます。 
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マウスでダブルクリックする

と下のマップが現れるように

なります。マップとマップの

関連付けができます。 
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リンクするものはマップだけではありません。任意のドキュメントへのリンクを貼れます。 

 
 

 

 

 
 
 
 

 

Wordドキュメントへ
のリンク 

ここをダブルクリックす
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

ると下の Word ファイル
が起動されます。 
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5.6 Topic Notesの挿入 

マインドマップはキーワードだけの情報が中心になりますので、どうしても詳細な情

報を付け加えるには不向きです。そんなときはMindManagerの Topic Notesの機能を

使います。 

 

 
 
 

 

トピックを選択した状態で

Topic Noteアイコンをクリ
ックします。 

 

 
 
 
 
 
 
 
 
 

画面右部に Topic Notes ウインドウが現れ
ますので、詳細な情報を付加します。 
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5.7 トピックの順序 

アイデアを考えるような場合、マインドマップのトピックの順序性はあまり関係あり

ませんが、順序を意識する必要があるマップもあります。MindManagerでは、右上が

スタート地点で時計周りと決まっています。マップを Text file,MS Word,MS Project

に exportしたときに、右上から順番に exportしていきます。 

 
 

 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
こ

け

Word fileへの出力 

 

れまでの説明で、MindManagerの基礎的な使い方を学びました。ここまでの知識だ

でもかなりのマインドマップが書けるはずです。 
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5.8 テンプレートを使う 

 同じようなマップを作るときには、予め用意されてテンプレートを使うと簡単にできま

す。例えば、議事録のマップを書くときにテンプレートを使った方法を説明します。 

1) File->Newから新規マップを作るための windowを表示させ、Open organzierを

選択します。 

 

 

 

 

2) テンプレート一覧からミーティングを選択します。 

 

注）MindManager X5購入時には、英語のテンプレートしかありませんが、ここでは

日本語化してテンプレートを使っています。 
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3) テンプレートにマップが画面に現れるので、サブトピックを追加してマップを完成

させます。 
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5.9 マーカーを使う 

 マップマーカーの機能を使うと、トピックに対して意味付けを与えることができます。意

味付けを、マップを見る人全員が共有することができれば、とても情報共有が簡単になりま

す。例えば、プロジェクトの作業がいくつかあった場合、それぞれに作業に対して優先順位

をつけることができます。 

 

このタブを

クリック 

優先順位２ 

優先順位１ 

 上の画面にあるように、画面右端のMap Markersというタブをクリックすると画面右に

マーカー一覧が表示されます。あるトピックを選択した状態で、１つのマーカーをクリック

すると、そのトピックの左端にマーカーが表示されます。このようにトピックに対して意味

付けを行うことができます。マップファイルを保存したときには、マーカーリストも保存さ

れます。つまり、他の人が、このマップを見たときに、マーカーの意味付けも共有できるこ

とになります。 

 ちょっとマーカーには賢いところがあります。トピックに割り付けられたマーカーをマウ

スで左クリックしていくと、優先順位が１から 2,3,4と移って行きます。 
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右

す

 

 

 

 

 

 
左クリックすると、1,2,3

と変わります。 

 

 

 

 

マーカーリストはデフォルトでは、英語のままです。下記画面で示すように、マーカーを

クリックしてModfiyを選択して、日本語に変えて置きましょう。これでぐっとわかりや

くなります。 
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6 応用編 

6.1 作業計画を立てる 

これまで述べた MindManager の機能を使えば、いろいろなプロジェクトの計画に

使えることがわかると思います。ここでは、簡単な例として、ある電機会社の商品企画

チームが社長から夏商戦に向けた新しいクーラーの提案を求められたとします。企画チ

ームのリーダーが、社長から言われたことをメンバに伝えるために、次のようなマップ

を作ったとします。 
 

図 6-1 クーラー新製品の提案 
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メンバにマップを見せながら議論するうちに、調査すべきものとして天気動向と電力

需要予想の調査が抜けていることがわかりました。そこで、リーダーは、それをマップ

に加え、それぞれの作業を誰がやるか担当を決めました。MindManagerでは、作業に

相当する各トピックに作業者を割り付けることができます。 

図 6-2 クーラー新製品の提案 作業者の割り付け 
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 Task Info ウインドウを出し、
各作業について開始日、進捗、

作業者を割り付けます 
 

 

図 6-3 クーラー新製品の提案 進捗率の設定 

Task Planningの機能を使うと、簡単に各作業について作業者を割り当てられますし、

進捗も表現できます。進捗１００％を設定すると、そのブランチの左端に×マークが

自動的につきます。 

プロジェクトが進行するにつれて、リーダーはこのマップを常に更新して、進捗率を

設定したり、漏れていた作業を追加したりして、プロジェクト情報を常に最新の状態に

保ちます。重要な課題、問題が発生したときは、それがよくわかるように色をつけたり

アイコンをつけたりして、メンバ全員に周知徹底をします。 

これで、MindManagerが作業計画を立案するのにも非常に役立つことがお分かり頂

けたと思います。 
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6.2 プロジェクト管理 

6.1では、プロジェクトの計画に役立つことを説明しましたが、MindManagerはプロ

ジェクト管理全般に役立ちます。プロジェクトを管理するための要素は次のマップで表

現できます。 

 
 

 

 
 
 
 
 
 
 
 
 
 

図６－３ プロジェクト管理のタスク 

 
既に図４－１でプロジェクトのマスターマップを示しました。このマップはすべての

プロジェクト情報への入り口となるもので、図６－３の情報をすべて網羅するように作

ることが可能です。 
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図６－３はプロジェクトを管理する側面から見たタスクを表現していますが、実際に

プロジェクトを実施する作業が抜けています。ソフトウエア開発のプロジェクトを例に

取りますと、要件定義、設計、実装、テスト、納品、保守、運用といった一連の Acivity

の定義が必要です。MindMapで表現すると次のようになります。 

 

 

図 6-4 ソフトウエア開発作業工程(マインドマップ形式) 
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図 6-5 ソフトウエア開発作業工程(リスト形式表現) 
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図６－３で示したソフトウエアの開発工程は、標準的な工程を取り上げているだけ

で、大きなプロジェクトになると工程が５００以上にもなります。１つのマップで、そ

れだけたくさんの工程を表現するとわかりにくくなってしまいます。そのため、

MindManagerでは、ブランチを折り畳んだり、フィルタ機能で特定のブランチだけ見

る機能があります。 

 

 

図 6-6 ブランチの折り畳み 
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６．１でも説明したように各作業について作業者を割り当て、進捗率をマップで表現で

きます。 

 

 

図 6-7  ソフトウエア開発作業工程に作業者を割り当て、進捗率を入れたマップ 

これだけですと、線表（ガントチャート）がないのでスケジュールがわからないのでは

ないかと思われるかもしれませんが、MindManagerは MS Projectとの連携機能を持

っていますので、他のツールで補えば問題ないでしょう。 

 また、プロジェクト管理の計画の局面には、必ず作るべきマップがあります。例えば、

プロジェクトの目的、範囲を定義するマップ、リスク管理のためのマップ等があります。

このようなマップのテンプレートがあると便利です。MindManagerでは、このような

テンプレートを登録する機能があり、質問に答える形式で、マップを作ってくれる機能

があります。 

次のマップは、リスク要因のマップです。ポップアップウインドウの質問に答えてい

くと自然にマップが出来あがります。 
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図 6-8

 
 

 

 リスク評価のマップ 
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6.3 HTMLファイルの生成 

最近では、職場や学校でいろいろな情報がWebを介して発信されることが当たり前の

ようになってきました。ブラウザさえあれば、情報が見えるのですから、多くの人が使

うのは当たり前です。簡単に使えるものが最後には生き残ります。MindManagerも当

然のことながら、HTMLファイルを生成する機能を持っています。平たくいえば、Web

から見るためのファイルを作ってくれる機能です。この機能を使えば、MindManager

で作成したマインドマップをWeb上に公開して、関係者全員がその情報を閲覧できま

す。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

図 6-9 HTMLファイル生成を起動する画面 
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図 6-10  ブラウザで見たマインドマップ 

 36



6.4 プレゼンテーションモード 

MindManagerには、他人に対してプレゼンテーションする機能がついています。こ

れは、なかなか便利です。是非、使ってみて下さい。みなさんは、MS Powerpointで

プレゼンをすることが多いと思いますが、MindManagerはそれとは趣きががらっと違

って楽しめます。マインドマップは放射状に書かれているので、そのままだと説明しに

くいのですが、プレゼンテーションモードにすると、ブランチのある部分のみが、順番

に時計周りに表示されて行きます。 
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6.5 フィルタリング 

 基礎編で、マーカーの使い方を説明しましたが、それとフィルタリングの機能は関係があ

ります。まず、フィルタリングするとどうなるか見てみましょう。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

フィルタリン

グをすると 
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 この例では、優先順位１のトピックのみが表示されています。このようなフィルタリング

をすることは簡単です。マーカーリストの画面を出したときに、下記のようにマーカーの左

にチェックボックスがあります。まず、これをチェックします。次に下のほうにある”Filter 

and Select”をクリックすると、サブメニューがでますので、そこで”filter”を選択し実行し

ます。Remove filterを実行すると元に戻ります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

画面上部にも、フィルタリングのためのアイコンが用意されています。 

 

 

 

 

 

 
ここを左クリック 
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6.6 マルチマップ インポート&エクスポート 

 １つのマップがあまりに複雑になっていくと、どうしても一部を別のマップファイルとし

て定義したくなります。逆に、他のマップをトピックとして挿入したい場合もあります。そ

に応えるための機能が、マルチマップ インポート&エクスポートの機能です。 

 

1) マルチマップ インポート 

  挿入の基準位置となるトピックを選択した状態で、Insert->Mapを実行します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ファイルを選択します。 

ここをクリック 
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このようにメイントピックとして他

のマップ全体が挿入されます。 
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2) マルチマップ エクスポート 

次のようなマップがあったとして、メイントピックの背景以下を別のマップファイルにする

ことを考えてみましょう。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

“背景”というトピックを選択した状態で、File->Send to->MindManager(as new map)を実

行します。 
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別のマップを作るときに、中心のトピックとして作成するか、メイントピックとして作成す

るか聞いてきますので、選択して OKボタンを押します。 

 

 

 

 

ファイ

 

 

 

 

 

 

 

 

 

ルを保存するウインドウが出てくるので、ファイル名をつけて保存します。 
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実行結果が、次の画面です。背景はハイパーリンクとして別ファイルをリンクしています。 
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6.7 News Feeds 

 ブロッグ(blog)は、既に USではブレークして、日本でも blog siteを作っている人が増え

てきたようです。MindManager X5は、いち早く blog siteの RSS/RDFを読むための機能

を提供しています。簡単に言えば、blog site のニュースヘッダーを読む機能です。まず、

サンプルを見てみましょう。 
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この例では、asahi.comのニュースヘッダーリストが表示されています。各ヘッダーの右端

には、ブラウザのアイコンが付いていて、それをクリックすると実際のサイトに飛んで行き

ます。このように blog siteのヘッダーを読むための手順を以下に示します。 

 

1) Asahi.comでは、http://www3.asahi.com/rss/index.rdf というRSS/RDFが公開され

ています。それをまず登録します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ここをクリック 
 

 

 

 

 

RDF を入力し

て OK ボタンを

押します。 
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http://www3.asahi.com/rss/index.rdf


 

 

 

 

 

 

 

 

 

 

し

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ここに部品として

登録されます。 

Library のタブを

押します。 

2) 登録された部品(Map Part)を左クリックしたままで、トピックとなる位置まで移動

て落とします。自動的に、blog site にアクセスして、ヘッダー情報を取りに行きますの
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で、しばらく待ちます。 

 

 

新

 

 

 

 

3) Map part を右クリックすると、refresh のメニューがでますので、適時実行して最

の状態に保持します。F5を押すと、すべてのMap Partsが refreshされます。 
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